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Microsoft Word 

 
Microsoft Word adalah program aplikasi pengolah kata (word processor) yang biasa 

digunakan untuk membuat laporan, dokumen berbentuk surat kabar, label surat 

undangan, membuat tabel pada dokumen, dan sebagainya. Microsoft Word 2016 adalah 

aplikasi pengolah kata yang memungkinkan untuk membuat berbagai dokumen, 

termasuk surat, resume, dan banyak lagi. Navigasi antarmuka word dan terbiasa dengan 

beberapa fitur yang paling penting, seperti Ribbon, Quick Access Toolbar, dan tampilan 

Backstage. Word 2016 mirip dengan word 2013 dan word 2010. Jika sebelumnya sudah 

menggunakan versi di bawahnya, maka word 2016 tentunya sudah terbiasa.  

 

Memulai Microsoft Word 

Untuk memulai Microsoft Word, kita dapat melakukannya dengan beberapa cara, 

diantaranya ialah: 

1. Klik Start > pilih menu > Word.  

 

Microsoft Word akan terbuka, selanjutnya kita kenalan dengan bagian-bagiannya. 

Berikut adalah tampilan awal dimulai lembar kerja Microsoft Word 2016. 
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2. Mengenal Bagian-Bagian dalam Microsoft Word 

 

Penjelasan: 

1. Quick Access Toolbar: Secara default berisi tombol save, undo, dan redo. 

❖ Save digunakan untuk menyimpan dokumen 

❖ Undo digunakan untuk mengembalikan ke kondisi sebelumnya, jadi kalau ada 

pengaturan yang salah dan ingin dikembalikan lagi, klik ini. Undo bisa dilakukan 

dengan kombinasi keyboard CTRL+Z. 

❖ Redo, kebalikan dari undo, yaitu untuk mengembalikan ke kondisi setelahnya. 

2. Title Bar: Judul / Nama dokumen yang sedang dibuat. 

3.  Icon Control Window: Untuk melakukan minimize window, full window / 

windowed mode, dan mengeluarkan program. 

❖ Minimize window untuk menutup program sementara dengan mengecilkannya ke 

background dan bisa dibuka kembali untuk melanjutkan. 

❖ Full window/windowed mode untuk membuka program dengan ukuran full layar, 

dan windowed, untuk membuka program dengan ukuran yang tidak full layar 

sehingga bisa membukanya bersamaan dengan program lain di layar yang sama. 

❖ Tombol silang untuk menutup program. 

4. Tab Menu. 

5. Tell Me: Untuk mencari tools yang diinginkan. 

Fungsi ini bermanfaat sekali ketika kita ingin melakukan sesuatu tetapi tidak tahu 

letak dari perintahnya dimana. Misalnya kita ingin mengatur margin tapi tidak 
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tahu letaknya, jadi kita ketikkan saja "margin" di kolom tersebut dan akan 

langsung muncul pengaturan yang diinginkan. 

6. The Ribbon: Berisi sekumpulan tools yang terdapat disetiap Tab Menu. 

7. Vertical Ruler: Penggaris vertikal. 

8. Horizontal Ruler: Penggaris horisontal. 

9. Document Area: Lembar kerja di Microsoft Word dimana kita biasa ngetik. 

10. Vertical Scrollbar. 

11. Status Bar: Berisi banyaknya halaman, banyaknya kata, dan lainnya. 

12. Mode pembacaan dokumen dan pengaturan zoom. 

 

4. Cara Mengatur Tipografi (Mengatur Ukuran Font, Jenis Font) 

Sekarang kita akan mengatur penulisan di Microsoft Word, seperti mengatur ukuran 

font, jenis font, rata baris, dan lain-lain. 

Barusan teman-teman telah mengetik beberapa baris, sekarang blok seluruh tulisan 

yang telah dibuat, dan sambil dipraktekan. 

 

Pengaturan dasar tata penulisan terletak pada Ribbon Tab Menu Home. 

 

Gambar 4. Jendela Menu Tab Home 

Penjelasan perkotak dari kiri ke kanan: 

1. Kotak untuk menentukan gaya/jenis font; Kotak untuk menentukan ukuran font / 

teks; Untuk memperbesar font; Untuk memperkecil font; Mengatur penggunaan 

huruf besar atau kecil pada kalimat / teks; Untuk mengembalikan format penulisan. 

2. Untuk mengatur bullet; Untuk mengatur numbering; Untuk mengatur bullet and 

numbering. 

3. Untuk mengatur teks agar menjorok ke luar; Untuk mengatur teks untuk menjorok 

kedalam. 

4. Untuk menebalkan teks; Untuk memiringkan teks; Untuk menambahkan garis 

bawah pada teks; Untuk mencoret teks; Untuk membuat tulisan kecil dibagian 

bawah teks; untuk membuat tulisan kecil di atas teks (seperti pangkat contohnya); 

Menambahkan efek pada teks; Menandai teks; Mengatur warna teks. 
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5. Mengatur tulisan rata kiri; Mengatur tulisan rata tengah; Mengatur tulisan rata kiri; 

Mengatur tulisan rata kanan dan kiri. 

6. Untuk mengatur spasi. 

7. Menambahkan warna background teks. 

 

5. Cara Menyimpan Dokumen 

Untuk menyimpan dokumen, caranya: 

Klik Tab Menu File > Save, atau dengan menekan CTRL + S pada keyboard. 

 

Klik browse, tentukan letak penyimpanannya dimana. 

 

Masukkan nama filenya dan tentukan jenis filenya. 

Ada banyak jenis file yang terdapat dalam menu ini, diantaranya: 

 

Namun biasanya pilihan yang banyak digunakan adalah: 

1. Word Document: untuk menyimpan dengan jenis file Word yang sedang 

dijalankan. (dapat diedit kembali) 
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2. Word 97-2003 Document: untuk menyimpan dengan jenis file Word 2003. (dapat 

diedit kembali) 

3. PDF: untuk menyimpan dengan jenis PDF. (tidak dapat diedit kembali) 

 

 

6. Cara Mencetak (Print) Dokumen 

Untuk mencetak dokumen Microsoft Word, 

Klik Tab Menu File > Print, atau dengan menekan tombol CTRL + P di keyboard, 

lalu klik Print.  
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Memulai Bekerja Dengan Microsoft Word 2016 

1. Menentukan Format Kertas Pencetakkan 

Digunakan untuk menentukan jenis kertas, batas atas, bawah, kiri dan kanan 

pengetikan dan pencetakkan 

Langkah: 

a). Klik Tab Layout, Klik tombol dialog Page Setup 

 

b). Akan tampil 

 

 

❖ Tab Paper: Digunakan untuk menentukan jenis kertas, contoh: A4, 

Legal, Leter dll. 

❖ Tab Margin : Digunakan untuk menentukan batas atas, bawah, kiri dan 

kanan pengetikkan atau pencetakan pada kertas 

Memulai Bekerja Dengan 
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Margin terdiri dari: 

Top  →Batas Atas   Left  →Batas Kiri 

Bottom →Batas Bawah   Right →Batas Kanan 

Orientation terdiri dari: 

Portrait  →Mencetak secara vertical 

Landscape →Mencetak secara horizontal 

c). Klik Ok 

 

2. Menentukan Format Teks Pengetikan 

Digunakan untuk memformat bentuk teks, berupa: cetak biasa (Rugular), tebal 

(Bold), miring (Italic), garis bawah (Under Line), jenis huruf, ukuran huruf, warna 

huruf dll. 

Langkah: 

a). Ketik naskah, lalu blok teks/huruf yang akan diformat 

b). Klik Tab Home, klik tombol dialog Font 

c). Klik Tab Font 

Pilih Font : Pilih salah satu jenis huruf 

Pilih Font Style: Pilih style huruf (Regular/Biasa, Bold/Cetak Tebal, 

Italic/Cetak Miring dan Bold Italic/Cetak Tebal dan Miring) 

Pilih Size: Untuk ukuran besarnya huruf 

Pilih Font Color: Untuk menentukan warna huruf 

Pilih Underline Style: Untuk menentukan garis bawah pada huruf 

Pilih Effects: Untuk menentikan efek pada teks 

d). Klik Ok 

Atau: 

a). Ketik naskah, lalu blok teks/huruf yang akan diformat 

b). Klik Icon yang diperlukan seperti di bawah ini : 
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3. Menentukan Format Paragraph (Jarak Antar Baris Kalimat) dan Perataan 

Teks  

Digunakan untuk memformat jarah antar baris kalimat. 

Langkah: 

a). Ketik naskah, lalu blok naskah yang akan diformat 

b). Klik Tab Home, klik tombol dialog Paragraph 

c). Pilih general → Alignment (Untk menentukan perataan teks, yaitu : Left/Rata 

Kiri, Right/Rata Kanan, Centered/Rata Tengah dan Justified/Rata Kiri Kanan) 

d). Pilih Line Spacing: Menentukan jarang paragraph (single/satu, 1.5 spacing, 

double/dua) 

e). Klik Ok 

 

4. Membuat Daftar Berurut dan Daftar Bersimbol (Bullet and Numbering)   

Digunakan untuk membuat daftar dengan urut disertai angka atau abjad dan 

simbil/gambar. 

Langkah: 

a). Ketik naskah, lalu blok naskah yang akan diformat 

b). Klik Tab Home 

 

 
Bullets Numbering 
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c). Klik Combo Box pada Icon Numbering → Pilih salah satu bentuk numbering 

Change List Level: Untuk menentukan tingkatan number. 

Define New Number Format: untuk menentukan bentuk number. 

Set Number Value; Untuk menentukan awal mulainya number. 

f). Klik Combo Box pada Icon Bullet → Pilih salah satu jenis bullet 

Jika tidak ada Klik Define New Bullet → Klik Tombol Symbol → Tentukan 

jenis font → klik salah satu symbol → Klik Ok 

g). Klik Ok 

 

 

5. Membuat Kolom Koran  

Digunakan untuk membuat naskah menjadi beberapa kolom seperti Koran. 

Langkah: 

a). Ketik naskah, lalu blok naskah yang akan diformat 

b). Klik Tab Page Layout, klik Combo Box pada Column → More Colums 

 

c). Tampil 
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Pilih Presets:  

Untuk menentukan jumlah kolom yang akan dibuat (one → Satu Kolom, Two → Dua 

Kolom, Three → Tiga Kolom, Left →Kolom Kiri lebik kecil daripada kolom kanan 

dan Right → Kolom kanan lebih kecil daripada kolom kiri) 

❖ Number Of Columns; Untuk menentukan jumlah kolom yang akan dibuat 

❖ Line Between: Menentukan garis pemisah antar kolom (Jika di check List aka nada 

garis pemisahnya) 

❖ Equal Column Width: Menentukan lebar antar kolom yang sama besar 

d). Klik Ok 

 

6. Menyisipkan Gambar (Picture)  

Digunakan untuk menambahkan gambar pada naskah. 

Langkah: 

a). Ketik naskah, lalu blok naskah yang akan diformat 

b). Klik Tab Insert, klik Icon Picture 

 

 

 

 

 

 

 

c). Pilih This Device: Pilih file gambar dari folder yang diinginkan 

d). Klik Insert 

e). Jika terkoneksi dengan internet, dapat memilih online pictures dan mengambil 

gambar yang ada dalam internet 

 

7. Mengatur Gambar (Picture) Pada Naskah 

Digunakan untuk mengatur tata letak gambar pada naskah beserta ukurannya. 

Langkah: 

a). Klik tombol mouse pada gambar 

b). Arahkan kursor / mouse pada Fill handle → tarik pada fill handle untuk 

mengecilkan atau memperbesar gambar. 

c). Tarik gambar dengan mouse kearah teks yang diinginkan 
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d). Klik kanan tombol mouse pada gambar 

e). Klik tab layout: untuk menentukan format peletakan gambar 

 

❖ In line with text: teks akan berada di atas dan di bawah gambar, sebelah kiri dan 

kanan gambar akan kosong 

❖ Square: teks akan berada di atas, di bawah, di kanan dan di kiri gambar, 

mengikutu betuk kotak 

❖ Tight: teks akan berada disekeliling gambar dan mengikuti bentuk lekukan 

gambar 

❖ Behind Text: gambar akan ada di belakang teks 

❖ In Front Of Text: teks akan ada di belakang gambar, sehingga teks yang tertutup  

 

d). Klik Ok 

 

8. Membuat Tabel Beserta Rumus 

Digunakan untuk membuat daftar dalam bentuk tabel. 

Langkah: 

a). Klik Tab Insert → Klik Icon Table → Klik Insert Table 

b). Tampil Table Size (Untuk menentukan jumlah kolom dan baris tabel) 

Number of columns: masukkan jumlah kolom 

Number of rows: masukkan jumlah baris 

c). Klik Ok 
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9. Menggabung Cell Tabel 

Digunakan untuk menggabungkan dua atau lebih cell secara berurutan. 

Langkah: 

a). Blok beberapa cell yang akan digabungkan 

b). Klik Tab Layout → Klik Merge Cells pada kotak dialog Merge 

 

10. Memformat Judul Pada Kolom Tabel 

Digunakan untuk mengatur letak judul pada kolom tabel. 

Langkah: 

a). Blok judul yang akan diformat 

b). Klik Tab Layout → Klik Jenis perataan judul pada kotak dialog Alignment 

 

11. Menghapus Cell, Baris, Kolom dan Tabel 

Langkah: 

a). Blok cell →Klik Tab Layout  

b). Klik Delete pada kotak dialog Rows & columns. 

Tampil: 

Delete Cells  : Untuk menghapus cell tertentu dari table. 

Delete Colums : Untuk menghapus kolom tertentu dari table. 

Delete Rows  : Untuk menghapus baris tertentu dari table. 

Delete Table  : Untuk menghapus seluruh table. 

 

12. Menyisipkan / Menambah Baris dan Kolom Pada Tabel 

Fungsi : Untuk menambahkan cell baik berupa baris maupun kolom di sebelah kiri, 

kanan, atas ataupun bawah dari suatu cell. 
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Langkah: 

a). Blok cell →Klik Tab Layout  

b). Pada dialog Rows & columns 

Pilih: 

❖ Insert Above : Untuk menyisipkan cell satu baris di atas cell aktif. 

❖ Insert Below : Untuk menyisipkan cell satu baris di bawah cell aktif. 

❖ Insert Left : Untuk menyisipkan cell satu kolom di kiri cell aktif. 

❖ Insert Right : Untuk menyisipkan cell satu kolom di kanan cell aktif 

 

13. Memformat Bingkai dan Warna Latar Belakang Pada Tabel (Border and 

Shading) 

Fungsi: Untuk menentukan bentuk bingkai dan warna cell pada tabel. 

Langkah: 

a). Blok cell atau seluruh tabel →Klik Tab Layout  

b). Klik Properties pada kotak dialog Table 

c). Klik Tab Border: untuk menentukan jenis, ukuran dan warna bingkai 

d). Klik Tab Shading: untuk menentukan warna latar belakang 

e). Klik OK 

 

 

14. Mengurutkan Isi Tabel 

Fungsi: Untuk mengurutkan isi tabel secara Ascending ataupun Descending 

berdasarkan criteria tertentu. 
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Langkah: 

a). Blok seluruh tabel →Klik Tab Layout  

b). Klik Sort pada kotak dialog Data 

c). Tentukan jenis pengurutan 

d). Klik OK 

 

15. Membuat Rumus Matematika Pada Tabel 

Fungsi : Untuk membuat rumus perhitungan matematika. 

Langkah: 

a). Tempatkan kursor mouse pada cell yang akan dibuat rumusnya 

b). Klik Formula pada kotak dialog Data, mis: =a1*b1 

c). Ketikan rumus pada kotak Formula 

d). Tentukan Jenis Number Format 

e). Klik OK 

 

16. Membuat Tabulasi 

Fungsi: Untuk mengatur pelurusan teks atau data numerik relatif terhadap margin 

dokumen. Tab stop adalah titik perhentian yang telah didefinisikan dan berada 

sepanjang baris pengetikan.  

Langkah: 

a). Klik Tab Layout→ Klik Paragraph → klik Tab Indents and Spacing 

b). Klik tombil Tabs lalu tampil  

 

 

c). Pada kotak isian Tab Stop Position, ketik posisi tab stop yang anda inginkan. 

d). Pada bagian alignment, beri tanda atau klik salah satu option pilihan berikut : 
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❖ Left, untuk tab stop rata kiri. 

❖ Center, untuk tab stop rata tengah 

❖ Right, untuk tab stop rata kanan 

❖ Decimal, untuk tab stop rata pada titik decimal 

❖ Bar, untuk pembuatan garis tegak 

e). Pada bagian leader, beri tanda atau klik pada salah satu option pilihan berikut : 

❖ 1 None, jika tidak memakai karakter pada leader 

❖ 2 ……., jika memakai karakter pendahulu titik 

❖ 3 --------, jika memakai karakter pendahulu tanda penghubung 

❖ 4 _____, jika memakai karakter pendahulu tanda garis bawah 

f). Klik tombol Set, untuk memasang tab stop tersebut pada garis mistar. 

g). Ulangi langkah c sampai e untuk memasang tab stop yang lainnya. 

h). Jika ingin menghapus tanda tab stop, klik Clear pada tab stop position yang 

akan dihapus atau Clear All untuk menghapus keseluruhan. 

 

Selain dengan menggunakan kotak dialog Tabs, dapat dilakukan dengan pengaturan 

tabulasi dengan tombol toolbar Tab Alignment yang terdapat pada sisi kiri ruler. 

Tabel 1. Menu Bar 

Toolbar Perintah Keterangan 

 Left Tab Digunakan untuk tab stop rata kiri 

 Center Tab Digunakan untuk tab stop rata tengah 

 Right Tab Digunakan untuk tab stop rata kanan 

 Decimal 

Tab 

Digunakan untuk tab stop rata pada titik decimal 

 Bar Tab Digunakan untuk tab stop berupa garis batas tegak 

 

Untuk mengatur tab stop melalui garis mistar, langkahnya adalah sebagai berikut: 

• Tentukan jenis perataan tab stop yang diinginkan dengan mengklik tombol tab 

alignment yang terdapat pada sisi kiri mistar. 

• Arahkan penunjuk mouse ke garis mistar dan klik pada posisi yang diinginkan. 

• Untuk memindahkan posisi tab stop, drag tanda tab stop ke posisi yang diinginkan. 

• Untuk menghapus tab stop, drag tanda tab stop ke bawah atau keluar dari mistar. 
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Latihan: 

Desa Wisata 
 

esa wisata adalah komunitas 

atau masyarakat yang 

terdiri dari para 

penduduk suatu wilayah terbatas 

yang bisa saling berinteraksi 

secara langsung dibawah sebuah 

pengelolaan dan memiliki kepedulian 

serta kesadaran untuk berperan bersama 

dengan menyesuaikan keterampilan 

individual berbeda.  Desa wisata 

dibentuk untuk 

memberdayakan masyarakat 

agar dapat berperan sebagai 

pelaku langsung dalam upaya 

meningkatkan kesiapan dan 

kepedulian kami dalam menyikapi 

potensi pariwisata atau lokasi daya tarik 

wisata diwilayah masing-masing desa.

  

Tiga Komponen yang perlu diperhatikan sebelum mambangun desa wisata: 
1. Kondisi desa Sekarang 

2. Keadaan Masyarakat dan Struktur Organisasi 

3. Konsep Desa Wisata yang unik 

 

Adapun daftar Desa Wisata Terbaik versi Anugerah Desa Wisata Indonesia (ADWI) 

2021 sebagai berikut:  
 

 

 

 

 

 

 

 

 

 

Selamat Mengerjakan!! 

D 

No Nama Desa Wilayah 

1. Desa Wisata Nusa, Kabupaten Aceh Besar Aceh 

2. Desa Wisata Sungai Batang, Kabupaten Agam  Sumatera Barat 

3. Desa Wisata Kampuang Minang Nagari Sumpu, 

Kabupaten Tanah Datar  

4. Desa Wisata Apar, Kota Pariaman  

5. Desa Wisata Saribu Gonjong, Kabupaten Lima 

Puluh Kota 

Jenis Tab Stop Tab Stop Postion 
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Mail Merge 
Mail Merge adalah alat yang berguna yang memungkinkan Anda untuk menghasilkan beberapa 

surat, label, amplop, tag nama, dan lainnya menggunakan informasi yang disimpan dalam 

daftar, database, atau spreadsheet. Ketika memanfaatkan Merge Mail, Anda memerlukan 

dokumen Word (Anda bisa mulai dengan yang sudah ada atau membuat yang baru) dan daftar 

penerima, yang biasanya sebuah workbook Excel.(Merge, 2016) 

Berikut ini langkah – langkah pembuatannya:  

1. Dokumen Word 

a. Membuat dokumen baru: klik file – new – pilih  

b. Membuat header: Kop surat 

i. Klik menu insert – pilih header – pilih blank. 

 
lalu atur header = 3 cm & footer 2 cm 

 

  
ii. Tambahkan logo: klik menu insert – picture lalu pilih logo 

   
serta atur logo sebagai berikut: 

1. Klik menu Format lalu ubah Ukuran: Tinggi = 3 cm, lebar = 3  
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& Rata kiri: klik menu format – position – pilih yang left text

   

& beri teks sehingga seperti  

 
 

c. Badan surat. Ketikkan surat sebagai berikut :  

 

Nomor  : 421/314/TPQ/...../XII/2021 

Lampiran : - 

Perihal : Undangan Wali Murid 

 

Kepada: 

Yth. Bapak/Ibu Orang Tua/Wali Murid TPQ........ 

Di  

Tempat 

 

Dengan Hormat, 

 

Bersama dengan surat ini, Semoga Kita selalu dalam keadaan sehat wal'afiat 

serta selalu dalam lindungan-Nya. Aamin 

 

Melalui surat ini kami mengundang Bapak/Ibu/Saudara Orang Tua Wali Murid 

Taman Pendidikan Al-Qur'an al Muthoharoh untuk berkenan hadir pada: 

 

Hari/Tanggal : Senin, 30 Desember 2019 

Waktu  : Jam 08.30 wib 

Tempat : Gedung Utama TPQ Al Muthoharoh 

Acara  : Pembagian Beasiswa Santri 

 

Demikian pemberitahuan ini kami sampaikan, atas perhatian dan kehadiran 

Bapak/Ibu/Saudara sekalian, kami ucapkan terima kasih. 

 

   Jakarta, 10 Desember 2019 

   Hormat Kami, 

 

   Amelia, S.Pd.I 
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2. Menggunakan Mail Merge  

 

a. Buka dokumen Word yang ada (1) 

b. Dari tab Mailings, klik perintah Start Mail Merge dan pilih Step-by-Step Mail 

Merge Wizard dari menu drop-down. 

 
• Panel Mail Merge akan muncul dan membimbing Anda melalui enam langkah utama 

untuk menyelesaikan penggabungan. Contoh berikut menunjukkan bagaimana cara 

membuat formulir dan menggabungkannya dengan daftar penerima. 

Langkah 1: Dari jendela Mail Merge di sisi kanan jendela Word, pilih jenis dokumen yang 

ingin Anda buat. Dalam contoh kita, kita akan pilih Letters. Kemudian klik Next: Starting 

document untuk bergerak ke Step 2. 

 
Gambar Step 1: Select Document Type 

 

Langkah 2: Karena surat sudah diketik maka pilih Use the current document. 
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Gambar Step 2: Select Starting Document  

 

kemudian klik Next: Select recipients untuk beralih ke Step 3 

 

Langkah 3: Sekarang Anda memerlukan daftar alamat sehingga Word secara otomatis dapat 

menempatkan setiap alamat ke dalam dokumen. List bisa berada pada file yang sudah ada, 

seperti buku kerja Excel, atau Anda dapat mengetik list alamat baru dari dalam Wizard Mail 

Merge. 

Pilih Type a new list ➔ klik Create 

 
Gambar Step 3: Select Recipients 

 

Kemudian klik Customize Columns ➔ hapus list yang ada dengan mengklik tombol delete dan 

lakukan konfirmasi Yes. 
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Lalu klik tombol ADD untuk menambahkan list No dan Nama. 

   
 

Kemudian klik OK ➔ Kemudian isi list recipients nya : (dengan menekan New Entry untuk 

menambahkan data recipientsnya satu-persatu) 
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Isikan datanya sebagai berikut : 

NO NAMA 

1 Salman Harist Akmal 

2 Muhammad Wahyu 

3 Alif ibrahimovic kalis 

4 Muhammad Rifqy Baihaqi 

5 Fahmi Triyanto 

 

Lalu klik OK 

 

Kemudian simpan dengan address listnya dengan nama data. Klik save 

 
 

 

Dalam kotak dialog Mail Merge Recipients, Anda dapat mencentang atau hapus centang setiap 

kotak untuk mengontrol penerima yang akan digabungkan. Secara default, semua penerima 

harus dipilih. Setelah selesai, klik Close. 
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Klik Next: Write your letter untuk beralih ke Langkah 4. 

 
Jika Anda tidak memiliki list alamat yang ada, Anda dapat mengklik tombol Type a new list 

dan klik Create, kemudian ketik daftar alamat Anda secara manual. 

Langkah 4: Sekarang Anda siap untuk menulis surat Anda. Sisipkan no surat & nama dengan  

 
pilihan more item sehingga tampil jendela insert merge field. 
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lalu tempatkan sesuai surat undangan seperti gambar dibawah ini 

 
Jika sudah ditempatkan field sesuai gambar diatas maka klik Next: Preview your letters untuk 

beralih ke Step 5 

 

Langkah 5: 

Preview suratnya untuk memastikan informasi dari surat tampil dengan benar. Anda dapat 

menggunakan panah gulir kiri dan kanan untuk melihat setiap versi dokumen. Seperti gambar 

dibawah ini  
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Jika semuanya sudah benar, klik Next: Complete the merge untuk beralih ke Step 6. 

 
Langkah 6: Klik Print untuk mencetak surat. 

 
Sebuah kotak dialog akan muncul. Putuskan apakah Anda ingin mencetak semua surat-surat, 

Current document (record), atau kelompok terpilih, kemudian klik OK. Dalam contoh kita, kita 

akan mencetak semua surat. 

 
Kotak dialog Print akan muncul. Ubah setelan cetak jika diperlukan, lalu klik OK. Surat-surat 

akan dicetak. 
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Selesaikan penggabungan. 

Latihan Basic 1 

1. Buka kembali file dokumen “Belajar 1 Maudy Ayunda”. 

2. Ketik teks dibawah ini dan manfaatkan berbagai fasilitas dasar yang tersedia di 

Microsoft Word ( Fokus Latihan : Clipboard, Font & Paragraph). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Simpan kembali Latihan 1 untuk menyimpan perubahan.  

MINUM TEH 

 Si Waen dan Wowu yang baru turun gunung, langsung keliling kota jakarta. setelah 

seharian keliling mereka kehausan, lalu menuju sebuah warung. Waen melihat daftar 

harga minuman: Teh dingin = Rp. 2000,- dan Teh panas = Rp. 1000,-   

  

Kemudian Si Waen memesan teh panas karena uangnya hanya 

Rp.1000,-. begitu pesanan teh panas datang, si Waen 

langsung meminumnya tanpa ditiup/didinginkan dulu, jelas 

aja dia kepanasan sambil memegangi tenggorokannya.  

Si Wowu kaget melihat itu: "kenapa, langsung kamu minum teh yang masih  panas itu?". Si 

Waen menjawab: "Nih lihat!, kalo tehnya udah dingin, harganya Rp.2000,-, mana cukup 

uangku?". 

 

Daftar Harga Makanan 
1. Nasi Uduk Rp. 10.000,- 

2. Ketupat Sayur Rp. 12.000,- 

3. Nasi Kuning Rp. 15.000,- 

Daftar Harga Minuman 
◼ Teh Panas Rp. 1.000,- 

◼ Teh Dingin Rp. 2.000,- 

◼ Kopi Hitam Rp. 3.000,- 

◼ Bajigur Rp. 5.000,- 



27 
 

Latihan Basic 2 

1. Buka dokumen baru dan beri nama “Belajar 2 Maudy Ayunda”. 

2. Ketik teks dibawah ini dan manfaatkan berbagai fasilitas dasar yang tersedia di 

Microsoft Word ( Fokus Latihan : Page Setup, Word Art, Shapes & Tabulasi). 

Ketentuan: 

❖ Margin : Top = 2,5 cm, Bottom = 3 cm, Left = 3,5 cm, Right = 2,5 cm  

❖ Orientation : Potrait,  Paper : A4 

 

 
 

Keberadaan gagdet yang sudah menjadi bagian keseharian 

anak sejak lahir, selain memberi kemudahan juga membawa hal 

yang bisa berbahaya bagi anak.  

enurut survei Google pada Februari 2015, rata-rata anak 

Indonesia menghabiskan waktu selama 5,5 jam sehari 

menatap layar smartphone-nya. Jika dibiarkan terus, maka 

keadaan tersebut lambat laun akan merusak anak. 

Pertama, perkembangan motorik. Kecenderungan anak yang bermain gadget 
berlebihan membuat kehilangan waktu untuk melakukan permainan yang 

melibatkan fisik. Hasilnya, banyak anak yang kesulitan pada keseimbangan tubuh.  

Kedua, perkembangan moral. Kita harus mengarahkan anak 

agar tidak melihat konten seperti kekerasan fisik, 

perbuatan asusila yang nantinya bisa merusak moral anak.  

Ketiga, perkembangan sosial. Ketika anak selalu sibuk dengan gadget, hal ini 

berakibat anak menjadi malas bersosialisasi. Padahal bersosialisasi sangat penting, 

karena mempengaruhi psikis seseorang. 

 

 

 

 

 

M 

Gadget dan 

Perkembangan Anak
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Latihan Tabel 

1. Buka dokumen baru dan beri nama “Belajar 3 Maudy Ayunda”. 

2. Ketik teks dibawah ini dan manfaatkan berbagai fasilitas dasar yang tersedia di 

Microsoft Word ( Fokus Latihan : Tabel dan Rumusnya). 

Ketentuan: 

❖ Margin : Top = 2,5 cm, Bottom = 2,5 cm, Left = 2,5 cm, Right = 2,5 cm  

❖ Orientation : Potrait,  Paper : A4  
 

REKAPITULASI 

NILAI ULANGAN TPQ NURUL HUDA 

Semester Ganjil Tahun Ajaran 2019/2020 

 

Kelompok  :  A1 

Nama Guru  :  Maudy Ayunda, S.Pd 

Mata Pelajaran   :  Membaca dan Menulis 

No Nama Lengkap Siswa 
Ulangan Harian Total 

Nilai 

Nilai 

Nil I Nil II Nil III Rerata Max Min 

1 Joko Widodo 7 6 8 21 7 8 6 

2 Susilo Bambang Yudhoyono 7 8 7 22 7.33 8 7 

3 Megawati 8 8 7 23 7.67 8 7 

4 Abdurrahman Wahid 9 9 8 26 8.67 9 8 

5 Bacharudin Yusuf Habibie 9 9 9 27 9 9 9 

6 Soeharto 7 8 9 24 8 9 7 

7 Soekarno 7 8 6 21 7 8 6 

 

Jakarta,  28 September 2019 

Guru Mata Pelajaran, 

 

Maudy Ayunda, S.Pd 

NIP : 200709417 
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Latihan Mail Merge 

1. Buka dokumen baru dan beri nama “Belajar 4 Maudy Ayunda”. 

2. Ketik teks dibawah ini dan manfaatkan berbagai fasilitas dasar yang tersedia di 

Microsoft Word ( Fokus Latihan : Membuat Surat Undangan Rapat ). 

Ketentuan: 

❖ Margin : Top = 2,5 cm, Bottom = 2,5 cm, Left = 2,5 cm, Right = 2,5 cm  

❖ Spasi Paragraph : 1.5 

❖ Orientation : Potrait,  Paper : A4  
 

KARANG TARUNA RT. 01/001 

KEL. TANJUNG PRIOK KEC. TANJUNG PRIOK 

JAKARTA UTARA 
JL.  TANJUNG PRIOK NO 05 

 

Jakarta, 1 November 2021 

Kepada Yth. 

Anggota Karang Taruna  

Tangjung Priok  RT. 01/001  

Di tempat. 

 

Perihal   :  Undangan Rapat  

 

Dengan hormat, 

Melalui surat ini, kami mengundang seluruh remaja anggota Karang Taruna RT. 

012/005  untuk dapat menghadiri rapat yang akan dilaksanakan pada : 

Hari / Tanggal : Sabtu, 3 Agustus 2019 

Waktu : Pukul 19.30 WIB 

Tempat : Kantor Sekretariat RT. 011/001 

Acara : Pembentukan Panitia Perayaan Kemerdekaan 

Demikian surat undangan ini kami sampaikan. Atas perhatian, kehadiran serta 

partisipasi rekan – rekan sekalian, kami ucapkan terima kasih.  

Hormat kami, 

Ketua Karang Taruna RT. 

01/001 

 

Maudy Ayunda 

 
Data Rapat Karang Taruna : 

RT Alamat Tempat Ketua 

012/005 JL.  SUNTER  MUARA I  NO. 12 A Kantor Sekretariat RT. 012/005 Maudy Ayunda 

015/005 JL.  SUNTER  MUARA II  NO. 73 B Lapangan Taman Hati RT. 015/005 Alyssa Soebandono 

016/005 JL.  SUNTER  MUARA III  NO. 35 C RPTRA Sunter Muara RT. 016/005 Nissa Sabyan 

 


